APA DOCUMENTATION STYLE: A BRIEF OVERVIEW

APA citation style refers to the rules and conventions established by the American Psychological Association for documenting sources used in writing a research paper. APA style requires two elements for citing outside sources: Reference Citations in Text and the Reference List. These documents credit the information sources and make it possible for others to retrieve this information.

This document provides basic information about APA format. For more detailed information, consult your instructor or LInC staff.

Table of Contents

Creating a Title Page or Cover Sheet Using Word 2007 ................................................................. 1
Formatting a Paper ............................................................................................................................... 6
Avoiding Plagiarism .............................................................................................................................. 7
Citing In-text Parenthetical References ............................................................................................ 7
Reference Page ..................................................................................................................................... 9
Sample Paper in APA Style ................................................................................................................ 14

Creating a Title Page or Cover Sheet Using Word 2007

1. Set your page specifications:
   • Under the “Home” tab, set your font and paragraph options as follows:
     a. Font: Times New Roman is the preferred font for APA
     b. Font size: 12
     c. In the paragraph box, the small button with several horizontal lines and arrows pointing up and down vertically is your line spacing control. Change line spacing to 2.0.

       ![Paragraph settings](image)

   • Under the “Page Layout” tab, double check that your margins are 1” all the way around (this should be the default setting, but always check to make sure).
   • Click on “Insert” then “Page Number” at the top of the home screen. Insert page numbers to be placed in upper right hand corner of each page.

Revised 3/2010
2. To create the Title:
   - Press enter until the cursor is approximately in the middle of the page. From the “View” tab, you can use the “Zoom” feature to see your entire page on the screen and observe where you are placing your cursor.
   - From the “Home” tab, “Paragraph” box, select center alignment.
   - Type the title of the paper. APA recommends no more than twelve words. If the title is more than twelve words, divide at a logical place.

3. To create the Byline (author’s name and institutional affiliation):
   - With the cursor at the end of your title, press enter once. Since you have already selected double spacing, the cursor should go down one double space. It should also remain centered.
   - Type your name, capitalized normally.
   - Press enter again and enter the name of your school.

The three cover sheets that follow are each examples of correct APA format options. Check with your instructor to determine if he/she has additional requirements for the coversheet.
Pay For College Athletes: A Dangerous Precedent

Student Name

Davenport University

Course Name (example: English 110)

Professor (insert name)

Date (fully written out; e.g. January 29, 2009)
Pay For College Athletes: A Dangerous Precedent

Student Name

Davenport University

Course Name (example: English 110)

Professor (insert name)

Date (fully written out; e.g. January 29, 2009)
Pay For College Athletes: A Dangerous Precedent

Student Name

Davenport University
Formatting a Paper

1. Margins must be at least one inch on all four sides.
2. Entire paper (including the reference page) should be double-spaced.
3. Paper should be left justified with no justification of the right margin.
4. Each page, from the title page through the reference page, should have a running header flush to the left margin (if the instructor requires it) and a page number in the upper right corner.
5. Use the tab key to indent a paragraph.
6. There should be two spaces after all end-of-sentence punctuation.
7. Font size should be 12 point using Times New Roman (preferred).
8. A completed paper should consist of some or all of the following (depending on course requirements): title page, abstract, main text with in-text parenthetical citations, reference page, appendices, author note, footnotes, table, figure captions, and figures.
9. Quotations – Quotes should include the author’s last name, year, and specific page.
   a. Short quotations (less than 40 words) should be incorporated into the text within double quotation marks (“ “).
   b. Long quotations (four lines or 40 words or more), also called block quotations, should be typed in a double-spaced block without quotation marks.
10. Headings- The first is for a major heading; the others are for subheadings beneath the major heading. Follow the pattern in the chart.

<table>
<thead>
<tr>
<th></th>
<th>Centered, Boldface, Uppercase and Lower Case Heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td><strong>Flush Left, Boldface, Uppercase and Lower Case Heading</strong></td>
</tr>
<tr>
<td>3</td>
<td><strong>Indented, boldface, lowercase heading, ending with a period.</strong></td>
</tr>
<tr>
<td>4</td>
<td><strong>Indented, boldface, italicized, lowercase heading, ending with a period.</strong></td>
</tr>
<tr>
<td>5</td>
<td><strong>Indented, italicized, lowercase heading, ending with a period.</strong></td>
</tr>
</tbody>
</table>
Avoiding Plagiarism

To avoid plagiarism, students must give credit when using information that is not their own. Information must be cited in text and on the reference page when:

- Copying three or more exact words of another person
- Paraphrasing (putting in your own words) or summarizing the ideas of another person
- Using statistics, graphs, charts, pictures, tables; only on Reference Page if discussed in text; source information always appears under the visual
- Using an idea or theory of another person

Citing In-text Parenthetical References

Brief parenthetical references in the body of a paper are tied to a reference list. The information needed in the parenthetical reference is an author’s last name, followed by a comma, and the year of publication.

The new art of photography would be accessible to millions of people (Boorstin, 1992).

If the author’s name is mentioned within the sentence, cite only the date:

Daniel Boorstin points out that photography would be accessible to millions of people (1992).

No parenthetical reference is needed if the date and author are both included in the sentence:

In 1992, Daniel Boorstin wrote about how photography became accessible to millions of people.

When citing a specific passage of a source, use abbreviations for the words page (p.), pages (pp.), chapter (chap.), and section (sec.):

Collins asserts that “great vision without great people is irrelevant” (2001, p. 42).
Specific In-text Parenthetical References:

A work by a single author: (Boorstin, 1992)

A work by two authors: (Cuppy & Steig, 1950)

A work by 3-5 authors:

First citation: (Smit, Hopper, & Jones, 1998)

Subsequent citations: (Smit et al., 1998)

A work by six or more authors: (Heinman et al., 2000)

A work by an organization or group:

First citation: (American Psychology Association [APA], 2003)

Subsequent citations: (APA, 2003)

A work with no listed author: cite the first key words of the title:

(“Disney Retreats,” 1994) for the title of an article in a magazine

(Disney Retreats, 1994) for the magazine title or book title

[note: use quotes for an article title, use italics for a magazine or book title]

An electronic source: author (shortened title in quotation marks if author not provided) and publication date

(Nicholas, 2004)

(“Beyond the Extreme,” 2006)

When In-text Parenthetical References Are Needed:

1. Direct Quotations (use of exact words and enclosed in quotation marks).
2. Summaries (a brief discussion of main points that does not use exact wording or original).
3. Paraphrases (explanation of another’s ideas using your own words).
Reference Page

The last page of the paper gives the full bibliographic information for all the sources cited. This page is labeled References and includes a double-spaced, alphabetical list by the author’s last name of all the sources used in the paper.

Format

1. Type the short title and page number in the upper-right corner, ½ inch from top of page.
2. Center the title, References, one inch from the top.
3. Begin each entry flush with the left margin. If the entry runs more than one line, indent additional lines approximately ½ inch (5-7 spaces) using a hanging indent.
4. Adhere to the following:
   - Double space between all lines on the references page.
   - Use one space following each word and two spaces after each final punctuation mark in an entry.
   - With book and article titles, capitalize the first letter of the title, the first word of the subtitle, if there is one, and any proper nouns.
   - Use italics for titles of books and periodicals, not underlining.
5. List each entry alphabetically by the last name of the author, or, if no author is given, by the title (disregarding A, And or The). For work with multiple authors, use the name of the first author listed in the publication.
6. Use the beginning initial of the first and middle names of an author (i.e. Smith, J. B.) with one space between the initials. For a work with more than one author, use an ampersand (&) before the final author’s name.
7. For publisher locations, use the full city name plus the two letter U.S. Postal Service abbreviation for the state, if outside the United States, city and country.

Specific Reference List Entries:

For electronic resources, include the same elements in the same order that you would for a print copy. Include retrieval information as needed to assist those accessing your source. Retrieval information is unnecessary when citing an often used database. The URL should be included when citing an obscure database. Retrieval dates are unnecessary unless the information may change over time.

Recent periodicals (journals, magazines, & newspapers) and even books may be assigned a DOI (Digital Object Identifier) that identifies and links to the source as well as replacing the URL as a reference. The DOI is a long string of numbers beginning with a 10. It looks like the following: doi: 10.1037/0278-6133.24.2.225. The DOI is usually found on the first page of the electronic article near the copyright notice. The Publication Manual of the American Psychological Association recommends using a DOI when available for both electronic and print sources.
• **A book with one author, print version**: Include in this order, the author’s last name and first initial, the year of publication in parenthesis, the book title in italics, and the publication information. Capitalize only the first words of titles and subtitles, as well as proper names.


• **Electronic version of print book—no DOI**


• **A book with more than one author**: Include all the author’s names (in the order listed on the title page).


• **A work by an organization or group (also known as a corporate author):**


• **An edited book**:


• **A selection from an edited collection or anthology**: The selection title is not underline but rather put in italics. Include inclusive page numbers, preceded by pp. (in parentheses).

• An article in a reference book, print version:


• An article in a reference book, online version with author:


• An article in a reference book, online version with no author:


• An article in a printed journal:


• An article in an online journal without a DOI:


• An article in an on-line journal with DOI:

• **An article from a website:**


• **An article from a searchable database:** If the DOI number is not shown, reference the article as a print article. Include the name of the database only if the source is rare, a print version is difficult to locate, or the material is only available on a small number of databases. No retrieval date is necessary for content that is not likely to be changed or updated.


OR

• **If the DOI is shown, include that:**


• **An article from a newspaper:**


• **An article from an online newspaper:**

• **Podcast:**


• **Data Set:**


• **Personal Communication:** cited in text only, you do not need to include on the Reference page.

  P. T. Bancroft (personal communication, July 6, 2009)

NOTE: Handbooks and online sources printed before 2009 may not have updated information available in the 6th edition of the *Publication Manual of the American Psychological Association*. If you have questions, contact your instructor or LInC staff.
APA Gone Wrong: Instructors Pulling Their Hair

Student Name

Davenport University

English 110

Professor John Smith

October 15, 2008
Abstract

The abstract begins at the left-hand margin with no paragraph indentation. The abstract is a summary of the article, told in 5-8 sentences and should be no longer than half a page. The abstract is told in third-person point of view, highlights the thesis and main points, but doesn’t repeat the thesis statement word for word.
APA Gone Wrong: Instructors Pulling Their Hair

The paper begins with an indented paragraph. Notice that there are no extra spaces between the title and the paper. The title repeats the FULL title from the cover sheet.

This sample essay is an example of how your papers must look when they are handed in. This font is Times New Roman with a twelve-point font. Notice how easy and pleasant this font is to read. Font size 14, Font size 16, and so on are obvious space fillers; easy to detect. Do not use them! The same goes for any fun or beautiful styles. While they may be fun to play with, they are horrible to read. Stick with Times New Roman or a similar font.

This essay is doubled-spaced. Notice that there are no extra spaces between paragraphs. If using Microsoft Word 2007, you’ll need to fix this error. Highlight your text if you’ve already started typing or change this option before you begin your paper. Click on the little arrow in the PARAGRAPH box on the HOME tab, then change the “after” spacing default from 10 to zero (0). All the numbers should be zero.

Some papers will require an Abstract, which goes after the Cover Sheet.

Note: If using Microsoft Word 2003, the margin default is 1.25". The one-inch margin is the standard for all businesses and publications, thus it should become your standard as well.

Have you ever noticed the red and green squiggle lines under some of your words as you type? Red indicates a spelling error. Green indicates a grammar error. BE CAREFUL that you do not accept the computer’s recommendations for ‘correcting’ grammar errors. If you don’t know the grammar rule, look it up in your handbook. Some computer “corrections” are wrong! Also, even though computers have spell checks, do not rely on them as they can make state the
word is spelling correctly; however, you could be using the wrong word. Proof your work. Hint: turn of the automatic spell checker, which corrects words as you type; for example, quite often *defiantly* will be replaced for *definitely*.

The poem below is an example of every word spelled correctly but the words are all used incorrectly.

Eye Halve a Spelling Chequer

Eye halve a spelling chequer
   It came with my pea sea
   It plainly marques four my revue
   Miss steaks eye kin knot sea.

Eye strike a key and type a word
   And weight four it two say
   Weather eye am wrong oar rite
   It shows me strait a weigh.

As soon as a mist ache is maid
   It nose bee fore two long
   And eye can put the error rite
   Its rarely ever wrong.

Eye have run this poem threw it
   I am shore your pleased two no
   Its letter perfect in it’s weigh
   My chequer tolled me sew

Sauce Unknown
References


All references go on this page and are double spaced with no extra spaces in between and no extra space between the title of “References” and your material.